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Abstract  

Facial reconstruction is a technique that can be used to estimate individual faces from human skulls. 

The presentation of 3D facial reconstructions as photo-realistic depictions of people from the past to 

public audiences varies widely due to differing methods, the artists’ CGI skillset, and access to 

VFX software required to generate plausible faces.  

 

This chapter describes three digital methods for the addition of realistic textures to 3D 

facial reconstructions; a 2D photo-composite method, a 3D digital painting and rendering method, and 

a previously undescribed hybrid 2.5D method.   

 

These methods are compared and discussed in relation to artistic proficiency, morphological 

accuracy and practitioner bias.   
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Introduction  

Facial reconstruction is a technique that estimates an individual face from a human skull, 

using established craniofacial standards, for forensic identification or archaeological investigation. 

https://orcid.org/0000-0002-7483-859X
https://orcid.org/0000-0003-1357-2721


While there are different facial reconstruction methods (Prag and Neave, 1997; Taylor, 2000; 

Wilkinson, 2005; Iscan and Steyn, 2013; Stephan, and Claes, 2016), most follow 

established and tested anatomical standards and procedural guidelines to create face 

shape (Wilkinson, et al. 2006; Lee, et al. 2012). Once the facial reconstruction shape is produced, 

a variety of primary, secondary and tertiary skin ‘textures’ are added, including wrinkles, creases and 

pores, followed by the addition of eyes, hair and additional accoutrements or clothing, plus colour 

information (Wilkinson, 2010; Roughley and Wilkinson, 2019; Roughley, 2020). For the purposes of 

this chapter, a ‘facial reconstruction’ describes the process of building a face from skull to skin layer. 

A ‘facial depiction’ is the outcome after textures have been added ready for presentation to public 

audiences.  

Representing faces from the past provides the publics with an opportunity to connect with 

historical figures both known and unknown, as individuals rather than concepts. Some believe the 

depiction could create empathy and personal connection between the viewer and the historical 

individual (Buti, et al., 2016). As scientific methods and visualisation techniques have developed, 

these representations have become more nuanced, realistic and detailed. 

Traditional facial reconstruction methods use skull images or casts, and, depending on the 

method adopted, anatomical modelling is performed in either two dimensions (2D) through drawing 

of muscles and facial features over an image of the skull (Taylor, 2001), or three dimensions (3D) by 

modelling the soft tissues using clay or wax onto a 3D replica of the skull (Prag and Neave, 

1997; Iscan and Steyn, 2013). Recently, and specifically over the past decade, facial 

reconstructions have been performed using 3D scans of human remains, digital processes and 

computer software adopted from the computer gaming, movie visual effects (VFX) and 

engineering industries (Claes, et al. 2010; Mahoney and Wilkinson, 2010; Roughley and Wilkinson, 

2019).  

     

Existing facial reconstruction methods   

2D facial reconstructions are based on frontal-facing photographic or 3D scan images of a 

human skull (or cast) positioned in the standard Frankfurt Horizontal Plane. Prior to the image being 

captured, the skull or skull cast will have soft tissue-depth markers attached at skeletal landmarks, 

correlating with the estimated biological profile. The facial reconstruction can be produced manually 

or digitally by drawing, sketching or employing composite image techniques on top of the image of 

the skull following established craniofacial estimation guidelines (Taylor, 2000).  

A composite image technique uses a collage of sourced images of human faces, skin, eyes, 

hair and clothing, to build a facial depiction. Figure 1 shows a 2D digital facial depiction of a WW1 

German soldier excavated from a battlefield near the French Village of Bullecourt. A 3D scan of the 

skull was imported into the 3D software, Geomagic Freeform, where soft-tissue markers and eyeballs 

were added. A 2D screenshot of the prepared skull was then exported into image graphics software 



Adobe Photoshop CC, where the facial muscles, features and face shape were drawn in 2D, prior to 

the addition of realistic textures via image compositing. 

 

    
Figure 1: 2D digital facial depiction of a WW1 German soldier excavated from a battlefield near the 

French Village of Bullecourt. Image courtesy of Face Lab, Liverpool John Moores University. 

 

3D facial reconstructions can be produced manually by sculpting in wax or clay on top of a 

replica of the skull as shown in figure 2 (Wilkinson 2010; Iscan and Steyn, 2013) or digitally using 

3D scans of the skull and virtual sculpting in computer software as demonstrated in figure 3 

(Mahoney and Wilkinson, 2010). Both methods follow established facial estimation guidelines. After 

skeletal analysis, soft-tissue depth markers, muscles and fat layers are added to the skull, followed 

by sculpted facial features and the final face shape. Alternative algorithmic and 3D 

modelling methods also exist, whereby a craniofacial model/template is morphed to fit the skull 

(Claes et al. 2010; Miranda, et al. 2018).   

 



 
Figure 2: Manual 3D facial reconstruction using a plaster cast of a skull and modelling wax. 

Image courtesy of Face Lab, Liverpool John Moores University. 

 

       
Figure 3: 3D digital facial reconstruction produced in Geomagic Freeform of an older 

Roman female found by KDK Archaeology as a single isolated burial during excavations at the Old 

Palace Lodge hotel, Dunstable, Bedfordshire. Image courtesy of Face Lab, Liverpool John Moores 

University. 

 



Digital 3D facial reconstruction methods afford certain interactions that make them highly 

desirable, including a non-destructive workflow, the ability to magnify anatomical details and engage 

with views of the 3D models that are otherwise not visible, and the display of complex anatomical-

spatial relationships more effectively than 2D images (Challoner and Erolin, 2013; Roughley and 

Wilkinson, 2019; Parsons and MacCallum, 2021). Although the prediction of face shape (facial 

reconstruction) follows anatomical standards with known accuracy (Wilkinson, et al. 2006; Lee, et al. 

2012), the final presentation of these digital facial reconstructions as photo-realistic faces (facial 

depiction) often depends on the skillset of the facial depiction practitioner, including their CGI skills, 

and access to 3D software. Therefore, there is often variation in the aesthetic success of the final 

depiction. 

 

What is the purpose of a facial depiction?   

Craniofacial analysis and reconstruction for forensic application usually occurs when all 

usual investigative channels have been exhausted. The craniofacial identification process produces a 

depiction or ‘likeness’ of the individual to generate further investigative leads. For example, under 

certain circumstances, such as national media circulation of the image, the face image may trigger 

recognition by family and friends. 

 In order to produce a more realistic representation of the individual, many forensic facial 

depictions utilise the addition of textures such as wrinkles, hair, and/or colour (Prag and Neave; 1997 

Vanezis and Vanezis, 2000; Taylor, 2000; Kahler, et al. 2003; Wilkinson, 2005; Claes, et 

al. 2010; Fernandes, et al. 2013). The texture is often a ‘best guess’ based on forensic evidence, 

biological profile, and circumstantial evidence. Some features, such as the hairline, are blurred in the 

final image, as it is not possible to ascertain this from the skull alone, and such 

detail could affect recognition (Frowd, et al. 2012). Depictions are often presented in black and white 

to reduce distractions due to the application of incorrect skin, hair and eye colour (Taylor, 

2000; Vermeulen, 2012). 

The main purpose of craniofacial analysis and reconstruction of archaeological human 

remains is rehumanisation and promotion of audience empathy with people from the past. A number 

of projects have used archaeological facial depictions to represent historical, migratory populations 

(Hamre, et al. 2017); re-present ancient human remains as people rather than artefacts in museum 

display settings (Crossland, 2009; Smith et al. 2020); re-humanise ancient Egyptian human remains to 

restore a sense of dignity and personhood (Smith, et al. 2019) and represent people from the past with 

facial differences (Smith, 2018; Wilkinson, 2018).  

 Depending on the information available, most archaeological depictions use historical 

records in conjunction with biological information to create full-colour, realistic facial depictions of 



the individual. This supporting information may include analysis of portraits held by public art 

galleries, genealogy analysis and evaluation of physical descriptions in written records (Wilkinson, et 

al. 2019). In recent years, it has been possible to utilise forensic DNA phenotyping or ancient DNA 

(aDNA) analysis to more accurately suggest skin colour, eye colour and hair colour of ancient human 

remains (Hamre et al. 2017). These suggestions allow the practitioner to produce a more realistic 

and valid depiction of the individual.   

 

3D Digital Texture Methods   

Manual 3D facial reconstructions produced using skull casts and clay or wax modelling 

materials can either be presented as ‘clay’ or solid colour models or painted in a realistic 

manner. With digital 3D facial reconstructions, once a face has been reconstructed virtually from the 

skull using 3D sculpting software, the finished reconstruction will also appear as a ‘clay-like’ model, 

lacking details and texture (figure 3). Different methods can be used to add ‘textures’ to 

these digital faces in order to achieve a photo-realistic result for publication or display. Once 

textured, digital 3D facial depictions can be presented either as still images, 3D animations, or 3D 

printed models (Roughley and Wilkinson, 2019).  

Figures 4 and 5 show a digital 3D facial reconstruction of King Robert II (Robert the Bruce) 

of Scotland created in Geomagic Freeform. Figure 4 shows the digital 3D facial reconstruction model, 

and with the addition of digitally painted skin textures, including eyes, hair and clothing. A still image 

from a 180-degree turntable animation is also presented. Figure 5 shows the same digital 3D facial 

reconstruction, but it has instead been 3D printed. Two different methods of adding textures to this 3D 

model are demonstrated, including spray-painting with a neutral solid grey colour (left), and realistic 

painting using acrylic paints and additional materials including hair and glass eyeballs (right). 

 

       
Figure 4: 3D digital facial depiction of  King Robert II (Robert the Bruce). Image courtesy of Face 

Lab, Liverpool John Moores University and the University of Glasgow. 



 

 
Figure 5: 3D digital facial depiction of  King Robert II (Robert the Bruce), which has been 3D 

printed. Image courtesy of Face Lab, Liverpool John Moores University and the University of 

Glasgow. 

 

The following sections describe in detail, to facilitate replication, three methods of adding 

realistic textures to digital 3D facial reconstructions: a 2D photo-composite method, a 3D digital 

painting and rendering method and a hybrid 2.5D method. The hybrid 2.5D method for application of 

textures to facial 3D reconstructions has not previously been described in the literature. It is a 

combined approach whereby the skin layer of a 3D facial reconstruction model is digitally painted in 

3D software; then a front-facing still image is exported to an image graphics software where 2D 

photographic images are composited to add features including eyes, hair and clothing. This method 

allows for the production of photo-realistic faces in the absence of advanced 3D modelling and 

rendering skills, which are needed to add these features in high-end VFX software. 

While these methods describe applications of digital textures to 3D models for forensic and 

archaeological facial depiction purposes, they are transferrable and can be utilised for anatomical and 

medical visualisation. We offer pros and cons for each method and conclude that the 2D digital photo-

composite method might inadvertently increase morphological error due to the use of donor images in 

the final composite. We suggest that the 3D digital painting method for adding textures remains the 

most ideal workflow. The impact of cognitive biases on the choice and addition of realistic textures 

during the depiction process is highlighted. 

 

 



2D Digital Composite Method    
With the 2D digital composite method, a front-facing still image of a 3D virtual 'clay-

like' facial reconstruction is exported from the originating 3D software into an image graphics 

software. For the purposes of this workflow, Adobe Photoshop CC with a default workspace is used. 

Skin and other complex textures such as hair and clothing are added using donor photographs from 

face databases, by using photo-composite techniques.  

Figure 6 shows an example of the 2D digital composite method in action.. A 3D digital facial 

depiction of a 19th century individual unearthed on ‘Rat Island’, Portsmouth by Operation 

Nightingale (Osgood, 2018) was created in Geomagic Freeform. An image of the face model in the 

Frankfurt Horizontal Plane was exported to Adobe Photoshop CC for 2D composite texturing of eyes, 

hair and clothing. This method was appropriate for this project because the time taken to texture the 

3D model was greatly reduced, and only one front-facing view of the facial depiction was required for 

publication. 

 

 
Figure 6: Example of digital composite method: 3D digital facial depiction of a 19th century 

individual unearthed on ‘Rat Island’, Portsmouth created in Geomagic Freeform, then exported to 

Adobe Photoshop CC for composite texturing of eyes, hair and clothing. Image courtesy of Face Lab, 

Liverpool John Moores University. 

 

 Workflow 

The composite process begins in Adobe Photoshop CC with a frontal still image of 

the 3D facial reconstruction. Donor images: high-resolution photographic images of faces or 

facial features, are selected based upon morphology and their similarity to the age and 

ancestry of the individual. These images can be sourced from a photographic database 

of consenting donors, but, the most common access is via online sources downloaded from 

image search engines and repositories. These images should either be in the public 

domain, be Creative Commons licensed or accessed from research databases such as the 

London Face Dataset (2017) by 



De Bruine and Jones (https://figshare.com/articles/dataset/Face_Research_Lab_London_Set/5

047666) where there is explicit consent for use in such projects.  

The donor images are imported in new layers to composite the textures on top of the 

facial reconstruction image. It is good practice to label the new layers appropriately 

as there will soon be many layers to contend with. Folders and subfolders are also 

recommended. Depending on the donor images used, the lighting and face shape of the donor 

image may not match the facial reconstruction image; altering the ‘opacity’ of the donor 

image in the ‘Layers’ palette is important in order to make the underlying shape of the facial 

reconstruction visible while edits to the original donor image are taking place. An opacity 

level of 50% is recommended.  

 In figure 7, a photographic donor image of a nose has been imported as a new layer 

in Adobe Photoshop CC and added to a ‘Nose’ subfolder. In order to position the nose image 

in place, the ‘Move’ and ‘Transform’ tools are used. For greater control over the 

transformation of the donor image in order to ‘fit’ the underlying image of the facial 

reconstruction, the ‘Puppet Warp’ tool can be used. This tool lets the user add pins on the 

image to hold parts in place. Once all pins are placed, they can be grabbed and 

pulled to move the image into the desired position.   

 

 
Figure 7: The ‘Puppet Warp’ transform tool in action in Adobe Photoshop CC. 

 

https://figshare.com/articles/dataset/Face_Research_Lab_London_Set/5047666
https://figshare.com/articles/dataset/Face_Research_Lab_London_Set/5047666


For more advanced control of the image transformation, the ‘Liquify’ tool can be 

used. With the donor image selected in the ‘Layers’ palette, choose ‘Filter’ from the menu at 

the top of the Adobe Photoshop CC interface, then ‘Liquify’. Only the layer selected will 

appear in the window. To show the underlying layers including the imported image of the 

facial reconstruction, tick the ‘Show Backdrop’ box in the lower right of ‘Properties’ panel. 

Both images will be shown, one on top of each other. The tools to the left of the ‘Liquify’ 

window, including the ‘Foward Warp’ tool can be used to push the donor image to fit the 

shape of the facial reconstruction (figure 8). 

 

 
Figure 8: The ‘Liquify’ filter tool in action in Adobe Photoshop CC. 

  

As more donor images are added on additional layers, the ‘Eraser’ tool or ‘Layer 

Masks’ can be used to soften the edges of the images and blend them to create a smooth 

transition between images. ‘Layer Masks’ are less destructive than simply erasing parts of the 

donor image. A ‘Layer Mask’ to a can be added to a selected layer by choosing 'Layer' from 

the menu at the top of the Adobe Photoshop interface, then ‘Layer Mask’ and ‘From 

Transparency’. The mask layer will appear alongside the image in the ‘Layers’ palette (figure 

9). With the mask selected, the ‘Paintbrush’ tool can be used to hide parts of the donor 

image. Painting on the ‘Layer Mask’ with a key colour (black) will make the source image 

appear as though it is being erased. If a white colour is painted the source image will 

reappear. This non-destructive method allows the user to make subtle or radical 

adjustments and blend between donor images.   



 
Figure 9: Using ‘Layer Masks’ and altering ‘Opacity’ in Adobe Photoshop CC.  

 

It is recommended that multiple photographic donor images are used to create a 

textural composite, as this reduces the chance of unintentional recognition of the donor’s 

facial features or textures (Shrimpton, 2018). As more donor images are composited, colour-

correction adjustments will need to be applied to the images to increase visual appeal 

and tonally blend the different images together (see Brinkmann, 2008). The ‘Adjustments’ 

tools shown in figure 10 have been used on the two donor ‘nose’ images in the ‘Nose’ 

subfolder to tonally blend the two different images together to reach a convincing result.  

 



 
Figure 10: Making colour corrections to layers in Adobe Photoshop CC.  

 

In addition to compositing of photographic images, Adobe Photoshop CC facilitates 

digital painting of textures in layers atop the image of the 3D facial depiction. Colours can be 

selected from the colour palette or sampled from donor images using the ‘Eyedropper’ tool 

from the toolbar to the left of the interface. The selected colours can be painted on a new layer 

using one or more of the brushes in the ‘Brushes’ palette. These brushes can be customised to 

alter softness of the edge of the brush and opacity of the painted stroke for example. 

Additionally, custom brushes can be created to perform techniques such as scattering of 

colour, which may be helpful in adding details such as pores. Painting using digital brushes in 

two-dimensions is useful in blending between composited images, for anonymisation of 

donor images, addition of textures such as sunspots, and adding details that are not 

necessarily available from donor images such as scars. 

Once the compositing process and any digital painting is complete, it is good practice 

to flatten the image under the ‘Layers’ menu, ready for export. This reduces the file size, 

however, it cannot be undone once saved so it is recommended to ‘Save As’ a new file. To 

save a high resolution image for print, a .TIFF image file type is recommended in CMYK 

colour mode. A .JPEG or .PNG image file type in RBG colour mode is recommended for 

screen or web display. The colour mode can be changed in the ‘Image’ menu 



under ‘Mode’. The facial depiction image can now be published via screen display, in print 

and circulated online or in the media. 

  

3D Digital Painting and Rendering Method   

For the 3D digital painting method, ‘clay-like’ 3D models produced from the 3D facial 

reconstruction process can be digitally textured by painting directly onto the 3D skin surface in 

software such as Pixologic ZBrush or Autodesk Mudbox. Once painted, the 3D model can be 

exported to VFX software such as Autodesk Maya where eyes, hair and clothing can be modelled. 

Final images can then be rendered using a rendering engine such as Arnold or VRay.  

Figure 11 shows a 3D digital facial depiction of the Medieval Abbot, John of 

Wheathampstead, textured using the 3D digital painting and rendering method. The facial 

reconstruction was created in Geomagic Freeform; exported to Pixologic ZBrush for digital texturing, 

and then exported to Autodesk Maya for modelling of eyes, hair and clothing, and final rendering in 

Arnold. St. Alban’s Cathedral, where John was twice abbot, and where his remains were discovered 

(Clark, 2020), requested that the public be able to ‘see’ the facial depiction from multiple angles. The 

3D digital painting and rendering method was required for the 3D facial depiction to be animated and 

the face viewed from differing viewpoints.  

 

  
Figure 11: Example of 3D texturing method. 3D digital facial depiction of Abbot John of 

Wheathampstead. Image courtesy of Face Lab, Liverpool John Moores University 

 

 

Workflow 

A completed 3D facial reconstruction's skin layer is exported as a .OBJ file from the 

software that it is generated in and imported into a digital sculpting and painting software. For 

the purposes of this workflow we used Pixologic ZBrush with a default 

workspace. Certain 3D modelling software allow for organic sculpting, whereby ‘virtual clay’ 

can be sculpted akin to sculpting with clay or wax in real life. This is often problematic as the 

topology or ‘mesh of polygons’ generated might be messy and unusable, especially for digital 



painting and animation of the 3D model. Re-topology can be undertaken to prepare the model 

for the next steps of the texturing process.   

Pixologic ZBrush has a number of built-in tools that allow for quick re-topology. 

These include the ‘ZRemesher’ and ‘Dynamesh’ tools. Both tools will automatically re-

arrange the polygons that comprise the model and organise them for use (Roughley, 

2020). Figure 12 shows the topology of a 3D model before and after 

‘ZRemeshing’. ‘Dynamesh’ is especially useful as when it is active, the mesh continues to be 

re-topologised as you sculpt. For facial animation projects, a more complex and rigorous re-

topology will be required to create useful edge loops and topology suitable for moving facial 

features. While this is not discussed in detail in this chapter, Autodesk Maya 

has comprehensive online guides for their ‘Quad Draw’ tool, which can be 

used for advanced re-topology (https://knowledge.autodesk.com/support/maya/learn-

explore/caas/CloudHelp/cloudhelp/2020/ENU/Maya-Modeling/files/GUID-74867E07-5CCD-

4D55-B60B-C90C3AD65DF4-htm.html).   

 

 
Figure 12: Topology of the skin layer of a 3D facial depiction before and after 'ZRemeshing’ 

in Pixologic ZBrush 

 

The next step in the 3D digital painting workflow is to generate a UV map. A UV 

map is the 2D representation of the surface of a 3D model, which is used 

to add textures. Creating a UV map is generally know as ‘UV unwrapping’. “The U and V 

https://knowledge.autodesk.com/support/maya/learn-explore/caas/CloudHelp/cloudhelp/2020/ENU/Maya-Modeling/files/GUID-74867E07-5CCD-4D55-B60B-C90C3AD65DF4-htm.html
https://knowledge.autodesk.com/support/maya/learn-explore/caas/CloudHelp/cloudhelp/2020/ENU/Maya-Modeling/files/GUID-74867E07-5CCD-4D55-B60B-C90C3AD65DF4-htm.html
https://knowledge.autodesk.com/support/maya/learn-explore/caas/CloudHelp/cloudhelp/2020/ENU/Maya-Modeling/files/GUID-74867E07-5CCD-4D55-B60B-C90C3AD65DF4-htm.html


refer to the horizontal and vertical axes of the 2D space, as X, Y and Z are already being used 

in the 3D space” (Denham, n.d). There are numerous ways to generate UV maps quickly 

in Pixologic ZBrush, however, the most effective method is to us the ‘UV Master’ plugin. 

With this plugin the automated UV mapping tool can be told to ‘Attract’ UV seams to 

specific areas of the model and ‘Protect’ other areas from seams appearing. For a 3D model of 

a face, the preferred location for UV seams is from the top of the head and down the back of 

the head towards the shoulders. This avoids the placement of UV seams across 

important landmarks and facilitates the production of a clean and usable UV map (figure 13). 

 
Figure 13: Results from UV mapping using the ‘UV Master’ plugin in Pixologic ZBriush. - 

location of UV seams in orange, and the subsequent UV map displayed 

 

As described in detail in “Pores, Pimples and Pathologies: 3D Capture and Detailing 

of the Human Skin for 3D Medical Visualisation and Fabrication” by Roughley (2020), the 

generated 3D skin layer can be sculpted with primary, secondary and tertiary forms. Each of 

these forms should be sculpted on a new layer in the ‘Layers’ palette in Pixologic ZBrush for 

optimal customisability. Using ‘Layers’ allows the user to use a slider to increase or reduce 

the intensity of one or more of the sculpted forms until a desired appearance is reached.  

In ‘Zadd’ or ‘Zsub’ sculpting mode, primary forms such as skin folds are added first 

using brushes from the ‘Brushes’ toolbox, including the ‘Dam Standard’ brush. Commonly, 

primary forms are sculpted at the lowest subdivision in the first instance. Then, at the highest 

subdivision, tertiary forms including micro-skin details are added to the entire surface of 3D 



model using a brush with a ‘DragRect’ or ‘Spray’ stroke and a greyscale image 

alpha. Secondary forms such as wrinkles and other distinguishing features such as 

scars follow the tertiary forms by using a combination of sculpting brushes and alphas. An 

image alpha would be something like a series of pores or crows feet as shown in figure 

14. Skin alphas can be downloaded from repositories including Pixologic ZBrush’s resource 

centre (https://pixologic.com/zbrush/downloadcenter/alpha/). This layering approach will 

produce good skin textures ahead of digital painting.  

 

Figure 14: Layering of skin ’textures’ through a combined use of sculpting brushes and 

alphas in Pixologic ZBrush 

 

Following the sculpting of these skin textures, the skin layer can be virtually 

painted with colour using imported digital photographs or virtual paintbrushes. The most 

effective approach to adding skin colour is to use a combination of these two methods. ‘Zadd’ 

or ‘Zsub; sculpting mode will be deselected and ‘Rgb’ colour mode will be selected in the 

upper toolbar to enable ‘Polypainting’. The 3D model is now ready for painting. To add 

a photographic donor image to the 3D surface, it first needs to be added to the ‘Spotlight’. In 

the ‘Texture’ menu at the top of the Pixologic ZBrush interface, click on ‘Import’, navigate 

to an image file on your computer and then select it. This image will appear in the ‘Texture’ 

menu. With the image selected in the ‘Texture’ menu, click on the ‘Add to Spotlight’ button 

below it. As shown in figure 15, the circular ‘Spotlight’ interface appears.  

https://pixologic.com/zbrush/downloadcenter/alpha/


It is recommended to place the 3D model into a position that allows for effective 

transfer of the donor image to the model, without distortion. In the ‘Spotlight’ wheel, reduce 

the opacity of the image to approximately 50%, and resize and reposition it until it is placed 

correctly atop the model. When ready to paint the image onto the skin surface, choose a 

‘Standard’ brush, ‘Freehand’ stroke, and a soft alpha. With these options selected, press ‘Z’ 

on the keyboard to hide the ‘Spotlight’ wheel and begin painting the donor image onto the 

model. Holding ‘Shift’ and ‘Z’ on the keyboard hides and shows the ‘Spotlight’ tool. This 

allows for alternation between the donor image and the painting results.  

  

 
Figure 15:Adding photographic skin textures to a 3D skin model using donor images and the 

‘Spotlight’ tool in Pixologic ZBrush 

 

Photographic donor images are helpful in applying realistic textures to a facial 

reconstruction, however, it is important to choose the right textures to suit the morphology of 

the face, as with the 2D Digital Composite method. To blend multiple donor images that have 

been added using the ‘Spotlight’ tool, colour and additional textures can be painted using 

custom brushes and alphas.    

With a chosen colour selected in the colour palette, a brush from the ‘Brushes’ 

palette can be chosen. Depending on the desired effect, it is recommended to either use the 

‘Freehand’, ‘Spray’ or ‘DragRect’ strokes, and a variety of alphas. It is useful to begin with 

a ‘Standard’ brush with a ‘Freehand’ stroke and no alpha. Alphas can be then be 

interchanged, for example, a ‘sprinkling’ of pores can be added by using the ‘Standard’ brush, 



a ‘Spray’ stroke and an alpha with a dotted pattern. For more controlled placement of alpha 

images, it is recommended to use the ‘Standard’ brush with a ‘DragRect’ stroke. Custom 

brushes and alphas can also be imported. Figure 16 shows a custom ‘pore-

controlled placement’ brush and alpha with a ‘DragDot’ stroke from Pablo Munoz Gomez 

(www.zbrushguides.com), used to carefully place additional skin details to a painted skin 

layer.  

If preferred, it is possible to skip the ‘Spotlight’ step and proceed directly to painting 

in this manner. Choose a colour in the colour palette and a brush from the ‘Brushes’ palette to 

paint with. We recommend choosing the ‘Standard’ brush, change the stroke to ‘Freehand’ 

and for now, do not add an alpha. With these tools selected, paint a base colour across the 

entire surface of the skin layer. Colour changes, discolouration, and fine details such as 

wrinkles, freckles and sun damage can be added following the steps in the previous 

paragraph.  

 

 
Figure 16: Adding skin details and additional colour using a variety of skin brushes and 

alphas in Pixologic ZBrush 

 

Once digital painting of the skin layer is complete, two additional ‘mapping’ steps are 

required prior to exporting the model for rendering in software such as Autodesk Maya. To 

create a ‘Diffuse’ texture map (this is the map the retains the colour that has been painted), 

navigate to the ‘Texture Map’ palette in the Pixologic ZBrush interface to the right of the 

http://www.zbrushguides.com/


screen. To complete this step, a UV map would need to be created first. Then click ‘Create’ 

and ‘From Polypaint’ I the ‘Texture Map’ palette. A ‘Diffuse’ texture map is generated (see 

figure 17).  

 

 
Figure 17: A 3D model and its generated texture map, visible in Pixologic ZBrush 

 

The next step is to create a ‘Displacement’ map. A ‘Displacement map’ contains all 

of the height and depth information from the sculpted skin textures in your 

layers. It allows for the export of a base model at its lowest subdivision for maximum 

usability in the subsequent VFX software, and then reapplies the highly detailed sculpted skin 

textures using a map. First, with the model at its highest subdivision, go to the ‘Layers’ 

palette and choose to ‘Bake All’ layers. This combines them into one, therefore, 

sculpting should be complete and chosen layer intensities settled upon. Next, with the model 

at its lowest subdivision, go to the ‘Displacement Map’ palette in the Pixologic ZBrush 

interface to the right of the screen, and select ‘Create DispMap’. A displacement map will 

be generated (see figure 18). To export the map for use in other software, choose 

‘Create And Export Map’. 

 



 
Figure 18: A 3D model and its generated displacement map, visible in Pixologic ZBrush 

 

The 3D head model and its associated maps are now ready for export. In the 

‘Geometry’ palette, the model should be moved to its lowest subdivision. The next step is 

to navigate to ‘Export’ in the menu at the top-right of the Pixologic ZBrush interface. Choose 

.OBJ as the file type and select a save location on your computer. When ‘Export’ is 

clicked, multiple files will be saved: the 3D mesh as an .OBJ file, a material as a .MTL file, 

and the diffuse maps as an image file.   

Open a VFX software and import the .OBJ of your 3D model, which will be at its 

lowest subdivision. For the purposes of this workflow we used Autodesk Maya 2020 with a 

default workspace. Any imported 3D models plus other 3D objects generated in Autodesk 

Maya can been seen listed in the ‘Outliner’ as shown in figure 19. To create a default 

workspace and file system on your PC (to hold assets, scenes and rendered images amongst 

other things), go to ‘File’ > ‘Project Window’ > ‘New’, rename the project and choose the 

desired save location on your computer. Then click ‘Select’.   

 



 
Figure 19: 3D model imported into Autodesk Maya, and the ‘Outliner’ window 

 

Once the model is imported into an Autodesk Maya 3D scene, a studio setup similar 

to a photography studio with a lighting rig will need to be created (see figure 20). At a 

minimum, a ‘floor’ and ‘walls’ should be added so the lights can be contained within the area 

where your 3D model is placed. From the menu at the top of the Maya interface choose 

‘Create’, ‘Polygon Primitives’ and ‘Plane’. Once the plane is inserted into the 3D scene, use 

the ‘Transform’, ‘Move’ and ‘Rotate’ tools from the left-hand toolbar to position it into the 

desired location. Do this as many times as required to create a ‘photography studio’. 

Reposition and resize the 3D head model to fit the studio space. Default ‘Perspective’ and 

‘Orthographic’ virtual cameras are added when a new scene is created, and the user can move 

between them by selecting them from the ‘Panels’ tab at the top of the viewport.  

Without lights in the scene, it will not be possible to visualise the 3D models when 

images are rendered. A standard 3-point light set up will illuminate the 3D models evenly and 

replicate real-world environments. To add lights, navigate to ‘Create’ in the menu at the top 

of the Autodesk Maya interface and choose ‘Lights’ then ‘Directional Light’. Once a light is 

inserted into the 3D scene, use the ‘Transform’, ‘Move’ and ‘Rotate’ tools from the left-hand 

toolbar to position it into the desired location. Do this as many times as required to create a 3-

Point light setup. The exposure, diffusion and temperature of the virtual lights can be adjusted 

accordingly in the 'Attribute Editor’ panel, found to the right of the Autodesk Maya interface. 

A warm soft pink light and a cooler soft blue light are recommended to be placed at either 



side of the 3D head, with a brighter white light pointing towards the face for optimum 

illumination. Experimentation with positioning of the lights and their associated settings is 

recommended until a desirable setup is reached. 

 

 
Figure 20: A studio setup and 3-point lighting system in Autodesk Maya 

 

The default material assigned to a 3D model when imported into Autodesk Maya is 

‘Lambert’, which is “a material (shader) that represents matte surfaces, such as chalk, matte 

paint, and unpolished surfaces with no specular highlights” (Autodesk, 2016). A different 

shader would need to be assigned for the surface of the 3D model to resemble human skin. In 

this example, with the 3D model eventually being rendered using the Arnold rendering 

engine, an ‘aiStandardSurface’ shader is used. This shader is capable of producing many 

types of materials (Autodesk Arnold,a) and a surface that resembles skin can be generated.   

With the 3D model selected, press and hold the right mouse button for the menu in 

figure 21 (left) to appear. Navigate to ‘Assign New Material’ and choose ‘aiStandardSurface’ 

shader. In the ‘Attribute Editor’, accessed to the right of the Autodesk Maya interface, the 

material shader options will appear. Click the ‘Presets*’ button and choose ‘Skin’ and 

‘Replace’. This shader is now applied to the 3D model and can be further customised by 

altering material settings and adding texture and displacement maps, either within the 

‘Attribute Editor’ or via the ‘Hypershade’ window (Autodesk, 2014a).    

 



Figure 21: Applying an ‘aiStandardSurface’ shader to a 3D model in Autodesk Maya 

 

With the 3D model selected, in the ‘Attribute Editor’, add the ‘diffuse’ colour texture 

map that was exported from Pixologic ZBrush to the 'Subsurface Colour’ node. Click on the 

checkerboard icon, then choose ‘File’ in the ‘2D Textures’ menu. Click the folder icon next to 

‘Image Name’ then navigate to the colour texture map on your computer and 

click ‘Open’. The colour texture map is now applied to the 3D model, as demonstrated in 

figure 22. If the texture map does not align correctly when applied and viewed in the 

Autodesk Maya viewport, the map may need to be transformed. Depending on the version 

of Pixologic ZBrush used to digitally paint the 3D model, the exported colour texture map 

might first need to be flipped horizontally to be in the correct orientation for use in Autodesk 

Maya.   

For additional customisation of the skin’s material properties, the ‘Subsurface’, 

‘Specular’ and ‘Sheen’ properties can be adjusted, however, the settings added earlier by the 

‘Skin’ preset should suffice. If the 3D model was resized, the ‘Radius’ in the ‘Subsurface’ 

properties may need to be reduced to avoid the skin layer appearing too washed 

out. A grayscale specular map can be added to the ‘Specular’ > ‘Colour’ node for 

more advanced control of where highlights appear on the skin surface.  

 



 
Figure 22: Applying texture maps and adjusting shader settings in Autodesk Maya 

 

The connections between the material nodes and shaders can be visualised in the 

‘Hypershade’ window. The ‘Hypershade’ window is accessed from the ‘Windows’ > 

‘Rendering Editors’ menu from the top of the Autodesk Maya 

interface. With the shader selected in the ‘Hypershade’, under ‘Shading Group Options’ click 

on the icon to the right of ‘Displacement mat.’ and the additional nodes will be added to the 

node tree in the viewport (visible at the bottom of figure 23). Click on the ‘image’ node and 

add the displacement map in the same way that the colour texture map was added to the 

‘Subsurface Colour’ node. In this node, select ‘Alpha is Luminance’ under ‘Colour Balance’. 

 



 
Figure 23: A node tree for a skin shader, highlighting the workflow for adding a displacement 

map to the 3D model in Autodesk Maya 

 

  To adjust the displacement settings select the 3D model in the ‘Outliner’ and under 

the ‘Shape’ tab in the ‘Attribute Editor’. Scroll down to ‘Subdivision’, select ‘catclark’ under 

the ‘Type’ with a recommended 4 iterations. This figure controls the subdivision of a 

surface and a higher number increases the displacement quality. However, a high value will 

also increase render time (Autodesk Arnold, b). Under ‘Displacement Attributes’ the ‘Height’ 

of the displacement map can be altered until the desired final appearance of skin layer is 

reached. Multiple test renders might be required. Adjustments to the virtual lights 

in the scene may be required if the model is too exposed or the scene is too dark.    

 



Figure 24: Altering displacement map settings in the ’Attribute Editor’ in Autodesk Maya 

 

To add realistic human eyes to the scene, eyes can be 3D modelled in Autodesk Maya 

or downloaded and modified under Creative Commons licenses to suit your project needs. 

These are available from online repositories such as TurboSquid and Sketchfab. For this 

workflow, 3D eye models freely available from the Autodesk website have been used 

(https://www.autodesk.in/campaigns/arnold/asset-3d-eye). Figure 25 shows the setup of these 

eye models in the ‘Hypershade’ window after importing the models, resizing them to fit the 

3D head, and connecting texture and displacement maps. The 3D eye models exist in two 

parts; the ‘eyeball’ and the ‘cornea’, with preloaded material settings for each. The colour 

texture map for the eyeball can be altered in Adobe Photoshop CC if the pre-existing iris 

colour is incorrect for the facial depiction. 

 

https://www.autodesk.in/campaigns/arnold/asset-3d-eye


 
Figure 25: The node tree and shader settings for 3D eye models available from the Autodesk 

website. Viewed in the ‘Hypershade’ window in Autodesk Maya 

 

At this stage, additional objects such as garments and jewellery can be imported or 3D 

modelled, and digital textures added to them following the aforementioned workflow. To 

create hairs, the XGen tool within Autodesk Maya should be used. XGen is a 

geometry instancer, able to create and style hair, fur, feathers, grass and forests (Autodesk, 

2014b). Select the 3D skin model in the ‘Outliner’ that hairs should populate from. To create 

hair in specific areas on the 3D model select the faces of the 3D model in the desired locations. 

Once a specific area of the 3D model is selected, click on ‘Create a new XGen description’ 

under the ‘XGen’ menu at the top of the Autodesk Maya interface. In the popup window, name 

the new description and click ‘Create a Collection’. To generate hair, select ‘Splines’ as a 

primitive, and to be generate ‘Randomly across the surface’. The controls should be ‘Placing 

and shaping guides’ (see Figure 26). 



 
Figure 26: Creating XGen Descriptions for hair modelling in Autodesk Maya  

 

Once ‘Create’ is selected, the new collection will appear in the ‘Outliner’ as a 

folder in green. Hair is generated by placing guides on the surface of the selected area. Hair 

will ‘grow’ according to the direction of the guides. Under the XGen tab, select the ‘Add or 

Move guides’ (the icon with a ‘+’), click on the surface of the model and adjust the guide 

using the ‘Transform’ and ‘Rotate’ tools from the left-hand toolbar. The guide can be moved 

by holding ‘Ctrl’ on the keyboard when ‘Add or Move guides’ is selected. The ‘Move’ 

tool from the left-hand toolbar is ineffective to adjust the position of the guide. The shape of 

the guide can be manipulated using ‘Sculpt guides’. Create a new description for different 

types of hair e.g. one for eyebrows, one for a beard, one for head hair etc. (see figure 27).  

 



 
Figure 27: Adding and editing XGen hair guides in Autodesk Maya, using different hair 

description for different hair types.  

 

The hairs can be visualised in the viewport by using the ‘Update the Preview’ (icon 

with an eye highlighted in figure 28). The ‘Generator Attributes’ tab in the XGen window 

(figure 27) can adjust the density and randomness of the hairs across the surface of the 3D 

model. The shape, length and width of the generated hairs can be adjusted under ‘Primitive 

Attributes’ (figure 27). To create realistic hair, ‘Modifiers’ such as ‘Noise’ and ‘Clumping’ 

can be added and adjusted, as shown in figure 28. Expressions can also be used to create more 

randomness in the structure, as explained in detail by JesusFC 

(https://jesusfc.net/tutorials/introduction-to-xgen). 

 



 
Figure 28: Visualising the XGen hair in the viewport with ‘Update the XGen preview’. The 

addition of modifiers to generate realistic hair using Arnold in Autodesk Maya.  

 

A new hair shader can be assigned to the hair systems in the ‘Hypershade’. The 

Arnold ‘aiStandardHair’ shader allows users to adjust the level of melanin, redness and 

randomness of the hair colours (figure 29). This is an intuitive system in adjusting the colour 

of the hair. 

 



 

 

Figure 29: Arnold ‘aiStandardHair’ shader with options to adjust the level of melanin, 

redness and randomness, to generate realistic hair using Arnold in Autodesk Maya.  

 

Throughout this process, test renders of the 3D scene can be performed at lower 

resolutions, which reduces render time. Select ‘Render’ from the top menu bar in the 

Autodesk Maya interface, then ‘Test Resolution’ and choose one of the reduced percentage 

settings. Then navigate back up to ‘Arnold’ in the menu bar and click ‘Render’ to render the 

scene in a new ‘Arnold RenderView’ window (figure 30). If the render doesn’t automatically 

start, click the ‘Play’ button. 



 
Figure 30: ‘Arnold RenderView’ in Autodesk Maya under ‘Arnold’. Test resolution can be 

adjusted from the ‘Render’ menu.  

 

When satisfied with the appearance of the 3D model, hairs 

and shader settings, a final image of the facial depiction can be rendered at 100% 

resolution. To choose an image format, change the render settings in ‘Render’ > ‘Render 

Settings’ from the top menu bar in the Autodesk Maya interface. Specific cameras, image 

formats, images sizes and image resolutions can be chosen here. For more advanced image 

rendering, the CPU and GPU settings can be changed in the advanced options. Please refer to 

this guide provided by Arnold for more information  

(https://docs.arnoldrenderer.com/display/A5ARP/Getting+Started+With+Arnold+GPU).  

Select ‘Render’ from the top menu bar in the Autodesk Maya interface and select 

‘Render Current Frame’. Any images rendered will be saved to the ‘Images’ folder within 

your Autodesk Maya project on your computer. The 3D model is often positioned to face the 

camera in the Frankfurt Horizontal Plane prior to rendering.   

If you were animating the 3D model, for example, getting it to move on a turntable, 

the models can be translated and rotated then keyframed in the scene by using the tools in the 

‘Animation’ menu and the timeline at the bottom of the Autodesk Maya interface. 

Alternatively, the camera can be animated to move around the 3D model. In ‘Render Settings’ 

choose start and end frame numbers for the sequence length, then choose ‘Render Image 

https://docs.arnoldrenderer.com/display/A5ARP/Getting+Started+With+Arnold+GPU


Sequence’ in the ‘Render’ menu to render all layers. For detailed animation and sequence 

rendering steps consult guides on the Autodesk Knowledge 

Network (https://knowledge.autodesk.com/support/maya/learn-explore.html) 

 

 

2.5D Digital Composite Method 

3D modelling of eyes, hair and clothing, plus skin material and virtual lighting choices that 

require advanced CGI skills can be time consuming to generate in VFX software. Like the 3D digital 

painting method, the hybrid 2.5D method adds skin textures directly on the skin layer of the 3D facial 

reconstruction model. However, more complex textures such as hair and eyes, are composited on a 2D 

image of the painted 3D model. 

Figure 31 visually demonstrates the 2.5D workflow. The image shows a digital facial 

depiction of a 1200-year-old bog body from Bernuthsfeld, East Frisia (Wilkinson and Roughley, 

2019) for which a front-facing 2D image of the face was requested. The 3D facial reconstruction was 

created in Geomagic Freeform and the skin layer of the 3D model painted in Pixologic ZBrush using 

the aforementioned 3D digital painting techniques. Eyes, hair and clothing were added to a 2D, front-

facing image of the facial depiction in Adobe Photoshop CC using the techniques described in the 2D 

digital composite method.  

When first approached by the archaeological team, the choice of eye colour, hair colour and 

style, and clothing materials were yet to be confirmed as scientific analyses of the human remains, 

which included preserved hair and fabrics were incomplete. The facial reconstruction and skin 

painting was undertaken and the depiction process was then paused until information regarding eyes, 

hair and clothing were made available from the scientific researchers. In addition to this flexible 

approach to working and an increased speed in texturing the face model, compositing these features in 

2D provided opportunities to produce multiple iterations of the depiction for consideration. For 

example, generating different combinations of clothing material and hairstyle, until a scientific and 

artistic consensus was reached. 

 

        

https://knowledge.autodesk.com/support/maya/learn-explore/caas/CloudHelp/cloudhelp/2020/ENU/Maya-Animation/files/GUID-66ED4510-CC1B-4E11-918B-B7DC447E38A7-htm.html


Figure 31: Example of 2.5 texturing method: 3D digital facial depiction of a 1200-year-old bog body 

known as "Bernie" created in Geomagic Freeform; exported to Pixologic ZBrush for digital painting; 

exported to Adobe Photoshop for composite texturing of eyes, hair and clothing. Image courtesy of 

Face Lab, Liverpool John Moores University. 

 

 

Workflow 

Like the digital 3D painting method, the skin layer of the 3D facial reconstruction is 

exported from the software that it was created in and imported into Pixologic ZBrush. The 

model will usually require a simple retopology, and the ‘ZRemesher’ tool can be used to 

create a mesh with organised topology ready for painting. If the mesh appears to have too few 

polygons, more can be added by using the ‘Divide’ button in the ‘Geometry’ palette. This 

increases the number of subdivisions that the 3D model has. It is recommended to also 

generate a UV map at this stage in case the model is to be used in VFX software in the future. 

The previously described method for UV mapping can be implemented, however, it may be 

unnecessary for this type of project, therefore simply pressing the ‘UV Unwrap’ button in 

‘UV Master’ will be sufficient. The 3D model will need to be at the lowest subdivision in the 

‘Geometry’ palette for UV unwrapping to take place. This can be increased to the highest 

subdivision level again prior to start the next stage. 

If desired, skin textures such as creases and wrinkles can be sculpted as demonstrated 

in figure 14, however, the 2.5D method can continue without the need for sculpted skin 

textures. Digital painting of the skin layer commences by using brushes and alphas or by 

using photographic donor images and the ‘Spotlight tool’. The workflow for digital painting 

(shown in figures 15 and 16) can be followed until the model is ready for export.   

Pixologic ZBrush also possesses a number of other tools that can be used prior to 

exporting the front-facing image, to enhance the photo-realism of the generated face image. 

These include adjustable material settings, built in virtual lights, and an integrated rendering 

engine. We have recommended the use of the ‘SkinShade4’ material when painting in 

Pixologic ZBrush due to its specularity adjustment options, and this material's properties (and 

any other material’s properties) can be altered in the ‘Material’ drop-down menu at the top of 

the Pixologic ZBrush interface. The diffuse colour, transparency or specularity settings could 

be changed to increase realism of the painted skin surface.  

The built-in lighting system allows the user to add, move and adjust the intensity and 

colour of the virtual lights in the 3D scene. The settings of these lights can be altered in the 

'Light’ drop-down menu at the top of the Pixologic ZBrush interface until a desired 

appearance is reached. The scene can be rendered using the inbuilt BPR renderer. This is 

found under the ‘Render’ drop-down menu at the top of the Pixologic ZBrush interface and it 



has options to adjust appearance features like shadow intensity. While the BPR renderer may 

not appear as effective as the Arnold render in Autodesk Maya, it is very quick and may 

enhance the photo-realism of the painted skin.   

When the model is sufficiently painted, instead of exporting the 3D model as an .OBJ 

file with its associated maps, go to ‘Document’ in the menu bar at the top of the Pixologic 

ZBrush interface and choose ‘Export’ (figure 32). This will allow for the export of the current 

view as an image file to be opened in Adobe Photoshop CC. It is recommended that the 3D 

model be placed in the Frankfurt Horizontal Plane and exported a frontal facing image.   

 

 
Figure 32: Exporting an image of the current scene from ZBrush as an image document. 

 

When the image is opened in Adobe Photoshop CC, digital compositing methods can 

be used to add realistic eyes, hair, clothing and accoutrements to the 2D image of the 3D 

painted facial depiction (figure 33). Once complete, the layer can be flattened and a final 

image can be exported for publication.  

 



 
Figure 33: Compositing of eyes, hair and clothing in Adobe Photoshop CC on top of an 

image exported from Pixologic ZBrush as an image document. 

 

Discussion   

Facial reconstruction and depiction visualizes a facial appearance of an individual from their 

skeletal remains. While the prediction of face shape follows anatomical standards and the accuracy of 

methods available have been established (Wilkinson, et al. 2006; Lee, et al. 2012), the texturing 

process is driven by the preference and skillset of the facial depiction practitioner, alongside access to 

required technologies and availability of supporting information relating to textural appearance. 

Technologies are also changing rapidly, and this requires a significant investment from the 

practitioner to learn or keep up to date with advancements. The three methods described in this 

chapter for adding textures to digital 3D facial reconstructions each have their own affordances, and 

although these methods are described in the context of adding digital textures to 3D models for facial 

depiction purposes, they are transferrable and can be utilised for anatomical and medical visualisation. 
 

Comparing Methods for Adding Digital Textures to 3D Facial Reconstructions  

Facial depiction practitioners can use various off-the-shelf image graphics software with 

image transformation and digital painting capabilities to add digital textures to facial depictions 

(Taylor, 2000; Roughley and Wilkinson, 2019). Adobe Photoshop CC contains suitable tools for 

adding digital textures to 2D images of 3D facial reconstructions. It facilitates compositing of 

numerous photographic images and digital painting to create realistic 2D digital facial depictions for 

display on screen, online or in print.  In comparison to the other two techniques described in this 

chapter, the 2D digital composite method is the fastest – taking approximately 8-10 hours to complete. 



It is also relatively low cost and does not require advanced 3D painting and VFX skills to add textures 

to 2D images of 3D facial reconstructions. 

Care should be taken when applying donor textures to the facial depiction image during the 

composite texturing process. Application of identifiable textures might inadvertently affect 

recognition or be recognised as the donor. Good practice is to use less than 10% of one donor image 

for anonymization. For individual features, Shrimpton (2018) suggests the compositing of more than 

two donor images per feature, and if one face donor image is being used to composite multiple parts 

of the facial depiction, no more than half of the donor face image should be used. With facial features 

that include identifiable biometrics (iris patterns and lip prints) it is possible to anonymise them. If the 

shape of these features has been chosen because they best match the morphology of the 3D facial 

reconstruction, but further anonymisation is required, parts of the features can be blurred, additional 

details digitally painted on new layers, and parts of the image can be swopped for parts of other 

images. For example, using a lip shape from one image and a lip print from another, or blurring the 

iris pattern.   

In addition to an awareness of the impact of applying identifiable donor textures 

to a depiction, caution when choosing and applying photographic donor textures should be taken 

to ensure that any ‘shape’ information transferred does not infer incorrect morphology. Errors can 

occur when attempting to texture an image of a 3D facial reconstruction with 2D images. In the 2D 

digital composite method, the contour, lighting and shape from the donor photographs can be difficult 

to match to the 3D shape of the facial reconstruction. This potentially creates opportunities for the 

suggestion of different morphology through the application of unsuitable textures.  

Figure 34 shows different photographic donor images of a nose applied to two iterations of 

the same 3D face model via the 2D composite method in Adobe Photoshop CC. Transformation of the 

donor images was limited to rotate, scale and opacity. It is demonstrated that the nose shape added by 

the image compositing process appears to be different to that of the 3D facial reconstruction and more 

advanced transformations are required if this donor texture is to be used. If caution is not taken to 

transform and edit the donor images sufficiently, the shape of the face can be affected.   

Shadows present on the image of the 3D facial reconstruction in the 2D digital composite 

method are important in helping to define morphology. These shadows are created by virtual lights in 

the 3D software where the facial reconstruction was created and they can be harnessed by duplicating 

the layer that contains the imported 3D facial reconstruction image and moving it to the top of the 

layer stack. Then, in the ‘Blend Mode’ drop-down menu in the ‘Layers’ palette, change ‘Normal’ to 

‘Multiply’. The image may appear oversaturated and require some minor image adjustments or a 

reduction in opacity to reach a desired finish but importantly, the morphology-defining shadows will 

remain.    

 



 
Figure 34: Potential impact on feature shape from different photographic donor images via 

the 2D digital composite method in Adobe Photoshop CC.  

 

ZBrush is a digital sculpture software that combines 3D modelling, texturing and painting, 

and its resemblance to traditional sculpture makes ZBrush easier to learn and adapt to than other 

available 3D modelling software. Its application in anatomical and medical visualisation has been 

effectively demonstrated (see Erolin, et al. 2017; Webster, 2017; Christ, et al. 2018; Erolin, 2019; 

Jędrzejewski, et al. 2020; Knight, et al. 2020; Maniam, et al. 2020; Šulek, et al. 2020; Adams, et al. 

2021), however, there is limited documentation of its use for texturing 3D facial depictions with only 

a small number of examples currently available (see Charlier, et al. 2019; Roughley and Wilinson, 

2019; Wilkinson, et al. 2019; Smith, et al. 2020; Martínez-Labarga, et al. 2021). 

The software facilitates digital painting and sculpting in three-dimensions and has real use in 

applying textures to 3D facial reconstructions. Unlike the 2D digital composite method, painting 

textures directly onto the surface of the 3D model, and compositing with the ‘Spotlight’ tool in 

Pixologic ZBrush, could reduce the likelihood of morphological errors occurring between the ‘clay-

like’ model and the final textured face. This is because the paintbrushes and projected images follow 

the contours of the 3D skin layer.  

Figure 35 shows a photographic donor image applied to two iterations of the same 3D face 

model. On the left, the digital 2D composite method was follow using a screenshot of the 3D model in 

Adobe Photoshop CC. The transformations applied to the donor image were rotate, scale and opacity. 

A ‘Multiply’ blend mode was also applied to use shadows from the facial reconstruction image. On 

the right is the application of the same donor image via the digital 3D painting method using the 

‘Spotlight’ tool in Pixologic ZBrush. The donor image was rotated and scaled, and the opacity 

reduced before being painted directly onto the surface of the 3D model. It is possible that ‘shape’ 

information from donor images can be transferred to the 3D model in both methods, however, the risk 

of extreme morphological error is reduced in the 3D digital painting method.   



 

      
Figure 35: The same photographic donor image applied to two iterations of one 3D face 

model. On the left, the digital 2D composite method was used with little transformation of the donor 

image. On the right, the digital 3D painting method and ‘Spotlight’ tool was used with little 

transformation of the donor image 

 

Working entirely in 3D enables the head model to be moved, viewed and textured from 

different angles (figure 36), unlike the 2D methods of facial depiction where only the frontal view is 

available. However, difficulties can arise when trying to apply 2D frontal-facing photographic donor 

images using the ‘Spotlight’ tool to the oblique surfaces of the 3D model. Unless there is access to 

donor facial images from multiple viewpoints – frontal, medial or lateral, it can be difficult to project 

2D textures onto 3D surfaces that are not directly visible in a frontal view, and some image distortion 

may occur. Painting skin textures using virtual and brushes directly onto the surface of the 3D model 

instead of using the ‘Spotlight’ tool avoids these difficulties and potential morphological errors 

adopted from donor images.  

  

 



Figure 36: 3D digital painting of skin textures directly onto the surface of the 3D model most likely 

reduces shape error compared to the 2D digital composite and 3D ‘Spotlight’ methods. 3D facial 

depiction of a 17th Century Scottish Solider unearthed at Durgam Cathedral. Image courtesy of Face 

Lab, Liverpool John Moores University. 

 

If the addition of textures using the ‘Spotlight’ tool is preferred, another option for texturing 

3D models with photographic images is to create a library of anonymised ‘textures’ in Adobe 

Photoshop CC and apply these to the 3D model. These textures do not include and ‘shape’ from the 

donor image but are simply square images with softened edges, as shown being used in the 3D digital 

painting method in figure 15. They can easily be composited using the ‘Spotlight’ tool, with 

additional blending and edits undertaken using virtual brushes and image alphas. Using these textures 

ensures that any shape information in the final facial depiction is driven by the shape of the 3D facial 

reconstruction.    

The realism and appearance of the 3D painted skin in the 3D digital painting and rendering 

method depends on the CGI skills of the artist, and additional access to software and hardware needed 

for rendering. Human skin has several properties that include “variation in colour, surface roughness, 

and translucency over different parts of the body, between different individuals” (Nagano, et al. 

2015), which make it difficult to replicate. The material properties of skin shaders applied to a 3D 

model in Autodesk Maya, such as sub-surface scattering, can be altered to produce more realistic 

outcomes with good success. However, an understanding of skin structure and reflectance 

(Angelopoulou, 1999), and the shader’s ability to “simulate the scattering of light beneath the surface 

of the skin” (Jensen, et al. 2001) is required for the skin to “appear fleshy and organic” (Nagano, et al. 

2015).  

Virtual lighting of a 3D facial reconstruction model in a 3D scene can be controlled to 

generate a desired aesthetic. Shadows are cast on the 3D model from the virtual lights in the 3D scene, 

and these shadows help to define morphology. Using the 3D painting and rendering method, the 3D 

depiction is unaffected by erroneous shadows that might be present from donor photographs applied 

during a composite texturing method.  

Tweaking the material shader and light settings in a 3D scene until a desired appearance is 

reached, will be a process of trial and error for individual practitioners. The skin material shader, sub-

surface and specular settings are easily affected by small changes to light intensity and colour. If a 

light is moved within the 3D scene or its intensity is changed, you may need to spend time re-

adjusting the skin shader settings and performing multiple test renders until the desired appearance is 

reached. This adds additional time and complexity to the 3D digital texturing and rendering process. 

Rendering time will also increase with the addition of 3D hair and clothing.  In comparison to the 

other methods described in this chapter the 3D digital painting and rendering method is the most time-



consuming and has the most complex workflow. A facial depiction textured using this method will 

take approximately 80+ hours. 
The 2.5D method requires some 3D modelling and painting skills, but no advanced 

VFX or rendering skills, or access to expensive rendering software and hardware. Similar to the 3D 

digital painting method, lighting can be controlled within Pixologic ZBrush, and painting directly onto 

the surface of the 3D model reduces the inference of incorrect morphology. This method reduces time 

compared to the digital 3D painting and rendering method, taking approximately 10-20 hours to 

complete a facial depiction. It could also increase accuracy when compared to the 2D composite 

method.  

Where possible, it is recommended that the digital 3D painting and rendering method is used 

to add realistic textures to 3D facial reconstructions, and that virtual lights are used to cast shadows. In 

the absence of advanced rendering and VFX skills, the 2.5D method presents a suitable compromise 

and a potentially more accurate methods of adding digital textures to 3D models than the digital 2D 

composite method alone.   

  

Artistic Proficiency and Cognitive Biases   

 The digital workflows described in this chapter use Adobe Photoshop CC, 

Pixologic Zbrush and Autodesk Maya with default workspaces, but it should be noted that “no two 

artists work identically or have identical training” (Erickson et al., 2016). Even if the 

base 3D reconstruction model is the same, artistic variability will result in different aesthetics on the 

textural layer, especially in relation to information such as hair, colour and surface details. There are no 

known studies that note if an artists’ proficiency with digital texturing software can affect 

the morphological accuracy of digital facial depictions. Further studies are required to establish this 

with certainty. 
Some studies highlight that artistic proficiency can affect recognition of an individual from a 

facial depiction in forensic settings. Erickson et al. (2016) suggest that the professional 

and artistic experience of the practitioner could be a contributing factor to the performance of a facial 

depiction for identification purposes. However, Lampinen et al. (2015) found no correlation between 

resemblance to the target and the experience or artistic training of the artist.  Even archaeological 

facial depictions, where there is access to historic written descriptions of the individuals, portraits and 

DNA analysis to suggest textural appearance, may rely on stereotypes in order to create super-realism 

(Wilkinson, 2020).  

The aforementioned 3D digital facial depiction of  King Robert II (figure 5) is an example of 

a multi-year project that involved an interdisciplinary research team to make decisions about the 

applied textures and overall presentation of the facial reconstruction based on available historical 

evidence. The application of brown hair and eye colour was informed by analysis of portraits of 

confirmed descendants held in art galleries by a geneticist at the University of Glasgow (Scotland), 



challenging the pre-existing stereotype of a blue-eyed and red-haired Scotsman. The bascinet and 

crown were produced through a collaboration between a curator of European Arms and Armour at 

Kelvingrove Art Gallery & Museum (Scotland), and a 3D artist, who used historic depictions of King 

Robert II (statues, coinage) and armour held in European museums as references (Wilkinson, et al. 

2019). Care was taken to ensure that the choices made were appropriate, down to the leather and 

twine materials used to attach the aventail to the bascinet, and the type of mail (steel rings with a 

domed fastening). However, not every project will have access to similar data, records or 

collaborators. 

Forensic DNA phenotyping provides more comprehensive details relating to individual 

appearance; the phenotyping process is useful for characteristics that involve pigmentation such as 

eye, hair and skin colour (Kayser, 2015), and the addition of this information to facial depictions can 

update or change portraits of people from the past. Figure 37 shows depictions of two Mesolithic 

individuals from Norway; cases where aDNA phenotyping suggested dark skin and blue eyes, 

contrary to popular theory for this ancient population.   

.  

 

   
Figure 37: 2.5D facial depictions of two Mesolithic individuals from Norway on display at Bergen 

City Museum. Image courtesy of Face Lab, Liverpool John Moores University 

 

However, caution must be taken when relying on forensic DNA phenotyping as it presents a 

spectrum of possibilities. In contemporary art, Heather Dewey-Hagborg’s artwork ‘Stranger Visions’ 

(2012-13) received criticism due to its ancestry bias in relation to textures chosen and applied to 3D 

printed face models produced from DNA profiling. The follow up work ‘Radical Love: Chelsea 

Manning’ (Dewey-Hagborg, 2017) drew attention to this problematic use of forensic DNA 



phenotyping through the generation of multiple (approx. 30) faces with different textural appearances 

from one DNA sample.   

Although the facial reconstruction process is rooted in scientific knowledge, subjective material 

is often added during the depiction process, especially when the facts prove insufficient for a realistic 

appearance. This subjectivity is conditioned by confirmation bias and any accepted knowledge/beliefs. 

The facial depiction practitioner should be aware of their own cognitive biases when applying textures 

to facial depictions, especially for forensic purposes whereby application of incorrect colour textures 

can affect recognition.  

One solution is to present facial depictions as solid colour models (see grayscale 3D printed 

replica of King Robert II in figure 5 as an example) to lessen subjective addition of textures that may 

be incorrect or shaped by cognitive biases. However, research has shown that the degree of 

realism in facial depictions influences their reception by the publics as valid faces (Lewis, 1997; 

Johnson, 2016), and that faces are generally more difficult to recognise without textural information 

(Bruce, et al. 1991). Textural information is therefore an important component of a facial depiction, 

however, the desire for hyper-realistic depictions of human remains, particularly for 

museum display, sometimes outweighs available evidence for justification of texture 

choices; potentially ignoring the fact that the chosen textures are some of many possible options 

(Wilkinson, 2020).  

Conclusion  
The presentation of a facial depiction can be critical to public perception, academic dialogue 

and scientific progress. This chapter describes three methods of adding realistic textures to digital 

facial depictions produced using 3D software: a 2D photo-composite method, a 3D digital painting 

and rendering method, and a previously undescribed hybrid 2.5D method. Each method has its 

advantages, including reduction in time taken to digitally texture a 3D facial reconstruction model, or 

increased opportunities to present facial depictions in different formats. The affordances of each 

method are highlighted, and it is suggested that the digital 3D texturing and rendering process for 

adding textures to 3D facial reconstructions can reduce the inference of incorrect morphology 

compared to the 2D digital composite method. It is recognised that practitioner biases may impact the 

choice of textures and final display of the facial depiction for public audiences.  
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